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Introduction 

This document provides instructions for configuring the Application Integration Framework (AIF) for 
data exchange using the BizTalk adapter. This document extends the white paper “Configuring the 
Application Integration Framework (AIF) BizTalk adapter for data exchange” by providing step-by-step 
instructions for the following scenarios: 

 Read a sales order from BizTalk.  

 Update a sales order from BizTalk.  

 Delete a sales order from BizTalk.  

Audience 

This white paper is designed for BizTalk developers and Microsoft Dynamics AX system administrators 

who are responsible for installing, configuring, and troubleshooting integration with external systems 
using AIF and BizTalk Server.  

Prerequisites 

To benefit from this white paper, you should have knowledge in the following areas: 

 The white paper Configuring the Application Integration Framework (AIF) BizTalk adapter for data 
exchange (referred to here as Part I) or equivalent experience in data exchange using the AIF and 
BizTalk. Step-by-step instructions and visual navigation provided in Part I are not repeated in this 
document.   

 Microsoft Dynamics AX Application Integration Framework (AIF) setup and configuration 

 Microsoft BizTalk Server 2006 R2 administration, including troubleshooting BizTalk applications 

 BizTalk Server application development 

 Microsoft Visual Studio 2005 

 XML schema of the documents exchanged 

You also need to have a test environment set up to follow the hands-on instructions. Setup of test 
environment is covered in a later section of this document.  

For information about configuration and maintenance of the AIF, see the Server and Database 
Administration Guide. For information about the AIF for software developers, see "Integrating Other 
Applications with Microsoft Dynamics AX" in the Microsoft Dynamics AX SDK Help. 

  

http://www.microsoft.com/downloads/details.aspx?familyid=edc62433-5b21-4f74-b065-b075ba6dc86d&displaylang=en&tm
http://www.microsoft.com/downloads/details.aspx?familyid=edc62433-5b21-4f74-b065-b075ba6dc86d&displaylang=en&tm
http://www.microsoft.com/downloads/details.aspx?familyid=edc62433-5b21-4f74-b065-b075ba6dc86d&displaylang=en&tm
http://www.microsoft.com/downloads/details.aspx?familyid=edc62433-5b21-4f74-b065-b075ba6dc86d&displaylang=en&tm
http://www.microsoft.com/downloads/details.aspx?familyid=edc62433-5b21-4f74-b065-b075ba6dc86d&displaylang=en&tm
http://www.microsoft.com/downloads/details.aspx?FamilyId=E7BFB7A8-EB99-4171-B75A-D9A37067BC19&displaylang=en
http://www.microsoft.com/downloads/details.aspx?FamilyId=E7BFB7A8-EB99-4171-B75A-D9A37067BC19&displaylang=en
http://www.microsoft.com/downloads/details.aspx?FamilyId=E7BFB7A8-EB99-4171-B75A-D9A37067BC19&displaylang=en
http://msdn.microsoft.com/en-us/library/aa877498.aspx
http://msdn.microsoft.com/en-us/library/aa877498.aspx
http://msdn.microsoft.com/en-us/library/aa877498.aspx
http://msdn.microsoft.com/en-us/library/aa496071.aspx
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Scenario Walkthrough 

This white paper provides step-by-step instructions for document exchange between the AIF and 
BizTalk server using synchronous mode. For detailed explanations of concepts and screen shots in the 
scenarios presented below, see the white paper Configuring the Application Integration Framework 
(AIF) BizTalk adapter for data exchange. For developer help, see the Microsoft Dynamics AX Developer 
Center. For administrative help, see the Microsoft Dynamics AX library on TechNet. For tips and tricks, 

see the AIF team’s blog.  

 Read a sales order from BizTalk. In this scenario, BizTalk will take an XML document from an 
inbound file folder and send it to the AIF. The document contains the entity key (sales order 
number) for a sales order. The AIF reads the sales order and sends the sales order to BizTalk. 
BizTalk sends the sales order to an outbound file folder.  

In the Visual Studio project, the orchestration to read a sales order from BizTalk will be called 
ReadSOSync.  

 Update a sales order from BizTalk. In the AIF, an update is a two step process. First, you need 
to read a sales order, then you update the sales order. For more information, see the “Updating 
Data With AIF” topic on MSDN.  

In this scenario, you will use the ReadSOSync orchestration to read a sales order. You will then 
modify the quantity in the sales order document and save it. You will place the modified document 
in an inbound file folder. BizTalk will send the document from the inbound file folder to the AIF. 
The AIF will update the sales order. The AIF response for the update operation does not have a 

return value by default. Therefore, the orchestration will use custom code to provide a return 
value in the response to BizTalk. BizTalk sends the response to an outbound file folder.  

In the Visual Studio project, the orchestration to read a sales order from BizTalk will be called 
UpdateSOSync. 

 Delete a sales order from BizTalk. In this scenario, BizTalk will take an XML document from an 
inbound file folder and send it to the AIF. The document contains the entity key (sales order 

number) for a sales order. The AIF deletes the sales order. The AIF response for the delete 

operation does not have a return value by default. Therefore, the orchestration will use custom 
code to provide a return value in the response to BizTalk. BizTalk sends the response to an 
outbound file folder.  

For more information about the delete action, see “Example: Delete Action ” topic on MSDN.  

In the Visual Studio project, the orchestration to delete a sales order from BizTalk will be called 
DeleteSOSync 

The following actions occur when you send an XML document from BizTalk to AIF. 

1. You place an XML document in an inbound file folder. In general, the format of this sales order can 
be Electronic Data Interchange (EDI) or another non-AIF format. For the scenarios described in 
this white paper, we are using the documents based on the AIF schema. This is a manual step in 
the walkthrough. However, you may have an automated process placing the sales order in the 
production environment. For more information on AIF messages and actions, see the AIF 
messages topic on MSDN. 

2. BizTalk Server monitors the file folder and sends the document to the AIF. In synchronous mode, 
BizTalk Server will bypass the AIF gateway queues and go directly to the AIF document services.  

3. Microsoft Dynamics AX processes the requested action (read, update, or delete). The AIF returns a 
response to BizTalk for the read operation with a return value by default. The orchestration will 
use custom code to provide a return value in the response for update and delete operations.  

4. BizTalk Server sends the response to the outbound file folder. 

5. You test the sales order to confirm valid test results. 

http://www.microsoft.com/downloads/details.aspx?familyid=edc62433-5b21-4f74-b065-b075ba6dc86d&displaylang=en&tm
http://www.microsoft.com/downloads/details.aspx?familyid=edc62433-5b21-4f74-b065-b075ba6dc86d&displaylang=en&tm
http://www.microsoft.com/downloads/details.aspx?familyid=edc62433-5b21-4f74-b065-b075ba6dc86d&displaylang=en&tm
http://msdn.microsoft.com/en-us/dynamics/ax/default.aspx
http://msdn.microsoft.com/en-us/dynamics/ax/default.aspx
http://msdn.microsoft.com/en-us/dynamics/ax/default.aspx
http://technet.microsoft.com/en-us/library/dd309624.aspx
http://blogs.msdn.com/aif/
http://msdn.microsoft.com/en-us/library/cc593511.aspx
http://msdn.microsoft.com/en-us/library/cc593511.aspx
http://msdn.microsoft.com/en-us/library/cc593511.aspx
http://msdn.microsoft.com/en-us/library/cc584466.aspx
http://msdn.microsoft.com/en-us/library/aa627117.aspx
http://msdn.microsoft.com/en-us/library/aa627117.aspx
http://msdn.microsoft.com/en-us/library/aa627117.aspx
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The next sections of this white paper provide step-by-step instructions and code to configure and test 
the document exchange. You can use this walkthrough to develop an understanding of how different 
components interact in this process and to test the results of the exchange. The objective of this 
document is limited to providing a hands-on experience with configuring the data exchange using the 

BizTalk adapter.  

Before you begin 

Consider the following points before you begin:  

 The test environment: This walkthrough uses the Microsoft Dynamics AX 2009 Pre-sales 

Demonstration Toolkit that is available for download at PartnerSource. PartnerSource is a secure 
portal that is available to partners who focus on Microsoft Dynamics and related business 
products. This Pre-sales Demonstration Toolkit includes two Virtual PC images. The first image, 
VPC 1, uses a server name of AX-SRV-01 and the second image, VPC 2, uses a server name of 
AX-SRV-03.  

This walkthrough uses a modified version of VPC 1. For this walkthrough, it is assumed that you 
have BizTalk Server, BizTalk adapter, and Visual Studio.NET installed and configured on VPC 1.  

 Setting up your own test environment: If you create your own test environment for this 
walkthrough, it should include the following components. For installation instructions, see 
Microsoft Dynamics AX Installation Guide. 

 Microsoft Dynamics AX 2009 base components with the Application Integration Framework 
(AIF) 

 Microsoft BizTalk Server 2006 R2, either Standard or Enterprise edition  

 Microsoft Visual Studio 2005, Professional Edition 

 AIF BizTalk adapter installed on the BizTalk Server host 

 Assumption: All the references to folder path and program navigation are based on the test 
environment set up in VPC 1.  

 Login ID: You need to know the login ID for various services, steps, and users. In some cases, 
you will also need to know the password. The test environment uses contoso\administrator as 
the user ID for all of the following steps or services. Password for the administrator account is 

“pass@word1”. The services or steps listed below are explained in later sections. 

 The domain administrator account and password. 

 The domain account and password used for the Business Connector proxy account. 

 The domain account used for Microsoft Dynamics AX Application Object Server and BizTalk 
services. 

 The domain account and password for the Admin user in Microsoft Dynamics AX 2009.  

Note: Using the same account for various services and users is a deviation from security best 

practices and is done here for ease of learning and troubleshooting. In a production environment, 
follow the documented best practices for Microsoft Dynamics AX, BizTalk Server, and Visual 

Studio. 

 Navigation in Windows: Navigation to frequently mentioned tools and programs is as follows:  

 BizTalk Server 2006 administration console: Start > All Programs > Microsoft BizTalk 
Server 2006 > BizTalk Server Administration 

 Microsoft Dynamics AX 2009 configuration: Start > Administrative Tools > Microsoft 
Dynamics AX 2009 Configuration 

 Microsoft Dynamics AX 2009 server configuration: Start > Administrative Tools > 
Microsoft Dynamics AX 2009 Server Configuration 

https://mbs.microsoft.com/partnersource/deployment/documentation/howtoarticles/presalesdemokitmdax2009.htm
http://go.microsoft.com/fwlink/?LinkID=99623
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 Viewing and managing services: Start > Administrative Tools > Services 

 Event Viewer: Start > Administrative Tools > Event Viewer  

 Microsoft Dynamics AX 2009 client: Start > All Programs > Microsoft Dynamics AX 2009 
> Microsoft Dynamics AX 2009 

 Navigation in the Microsoft Dynamics AX client: Navigation to frequently mentioned tools and 
forms is as follows:  

 AIF configuration: Basic > Setup > Application Integration Framework 

 AIF queue manager, exceptions, or document history: Basic > Periodic > Application 
Integration Framework 

 Batch jobs and tasks: Basic > Inquiries > Batch job 

 Sales order: Accounts receivable > Common Forms > Sales Order Details 

Step-by-step instructions  

There are a number of tasks that you need to complete for successful processing and testing of the 
document exchange using the AIF adapter. The walkthrough provides step-by-step instructions for the 
following tasks in next sections. 

 Configure AIF for the BizTalk adapter 

 Build and deploy the Visual Studio project 

 Create an orchestration to read a sales order 

 Create an orchestration to update a sales order 

 Create an orchestration to delete a sales order 

 Create a strong name key 

 Build and deploy the Visual Studio project 

 Configure orchestration in BizTalk Server 

 Configure the DeleteSOSync orchestration 

 Configure the ReadSOSync orchestration 

 Configure the UpdateSOSync orchestration 

 Configure AIF batch jobs, tasks, and recurrence schedule 

 Read the sales order and test results 

 Update the sales order and test results 

 Delete the sales order and test results 

 Troubleshooting 
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Configure AIF for the BizTalk adapter 

Make sure that the AIF is properly configured for the BizTalk adapter. You need to complete the 
following tasks to configure the AIF for the BizTalk adapter. For detailed instructions and visual 
navigation, see the Configuring the Application Integration Framework (AIF) BizTalk adapter for data 
exchange white paper.   

 Configure the transport adapter. 

 Configure the channel. 

 Configure services. 

 Configure local endpoints. 

 Configure endpoints. Configuration of endpoints is slightly different in this white paper than the 
instructions provided in Part I.  

Configure the endpoint using the following steps: 

1. Make sure that the Endpoint Action Policies form contains SalesSalesOrderService.read, 

SalesSalesOrderService.update, and SalesSalesOrderService.delete actions as shown in the 
following screen shot. You may have additional actions enabled. However, this white paper will 
only use the three actions mentioned in this step. For more information on the endpoint action 
policy, see the Configure endpoint action policy topic on TechNet.  

 

  

http://www.microsoft.com/downloads/details.aspx?familyid=edc62433-5b21-4f74-b065-b075ba6dc86d&displaylang=en&tm
http://www.microsoft.com/downloads/details.aspx?familyid=edc62433-5b21-4f74-b065-b075ba6dc86d&displaylang=en&tm
http://www.microsoft.com/downloads/details.aspx?familyid=edc62433-5b21-4f74-b065-b075ba6dc86d&displaylang=en&tm
http://technet.microsoft.com/en-us/library/aa834401.aspx
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2. For ease of learning, enable only the necessary fields instead of enabling all fields when you 
configure the data policies for this walkthrough. Enable fields for read and update actions using 
the following steps. Data policy does not apply to the delete action since there is no sales order 
document to exchange.  

a) Enable fields for the read action. In the Endpoint action data policies form, click the 
Set button and then click Disable all. Sort the data in descending sequence by the Required 
field. To sort the data, click on the column heading for the Required field. Navigate to and 
enable the SalesId field (SalesOrder/SalesTable/SalesId) to include the sales order ID in 
the document. Navigate to and enable the _DocumentHash field. The _DocumentHash field 
is required to implement concurrency in the update operation. For more information, see 
“Concurrency When Updating Data” on Microsoft Developer Network (MSDN). Sort the data in 

descending sequence by the Enabled field. Your form should resemble the following screen 
shot diagram.  

  

http://msdn.microsoft.com/en-us/library/cc639058.aspx
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b) Enable fields for the update action. For the update action, you do not require the SalesId 
field. Enable required fields and the _DocumentHash field. Your form should resemble the 
following screen shot diagram. 

c) You do not need to make changes to data policy for the delete action as it does not exchange 
a sales order document.  
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Build and deploy the Visual Studio project 

This section provides step-by-step instructions to create and deploy a Visual Studio project for 
creating the asynchronous orchestrations.  

Create a BizTalk project and add references 

1. Launch Microsoft Visual Studio 2005.  

2. Click File > New > Project … to launch the New Project window. 

3. Select Empty BizTalk Server Project. 

4. Enter values for the following fields. 

 Name = AIFSOWalkthrough 

 Location = Desktop (or any location of your choice) 

5. Click OK. 

Create an orchestration to read a sales order 

This section provides step-by-step instructions to create and configure the synchronous orchestration 
to read a sales order.  Use the following steps to create the orchestration. 

 Add the adapter metadata 

 Rename the orchestration 

 Add shapes to the orchestration. 

 Configure Multi-part Message Types 

 Create messages and set properties 

 Create and configure ports 

 Configure shapes 

Add the adapter metadata 

1. Right-click AIFSOWalkthrough in the Solution Explorer pane and select Add > Add 
Generated Items....  

2. In the Add Generated Items – AIFSOWalkthrough window, select Add Adapter Metadata 
and click Add button. 

3. When the Add Adapter Wizard opens, select Microsoft Dynamics AX 2009.   

a) Enter these field values:  

 SQL Server = AX-SRV-01 

 Database = BizTalkMgmtDb 

b) Click Next. 

4. In the BizTalk Adapter for Microsoft Dynamics AX Schema Import Wizard, enter values for 
Server Name and TCP/IP Port.  The server name refers to the Application Object Server (AOS) 
and the port refers to the port being used by the AOS. The port is usually set to 2712. You can 

look at the Microsoft Dynamics AX 2009 Server Configuration utility to obtain the server name and 
TCP/IP port. For more information, see the Server and Database Administration Guide. 

a) For this walkthrough, enter the following values: 

2. Server name = AX-SRV-01 

http://www.microsoft.com/downloads/details.aspx?FamilyId=E7BFB7A8-EB99-4171-B75A-D9A37067BC19&displaylang=en
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3. TCP/IP Port = 2712 

b) Click Next. 

5. Expand SalesOrderService and check delete: sync, read: sync, and update: sync. Click 
Finish. This orchestration will only use the read operation. The update and delete operations will 

be used later in the walkthrough. This document uses synchronous data exchange for ease of 
learning. The “Configuring the Application Integration Framework (AIF) BizTalk adapter for data 
exchange” white paper provides instructions for using synchronous and asynchronous 
orchestrations. 

6. In the Solution Explorer pane, right-click the References node, select Add references and 
then click the Browse tab.  Add Microsoft.Dynamics.BizTalk.Adapter.Schemas.dll from C:\ 
Program Files \ Microsoft Dynamics AX \ 50 \ Client \ Bin.  

Rename the orchestration 

Rename the orchestration to provide a meaningful name for the orchestration. 

1. In the Solution Explorer pane, right-click BizTalk Orchestration.odx and rename it to 
ReadSOSync.odx.  

2. Double-click ReadSOSync.odx. Select Orchestration View pane. Right-click Orchestration 

Properties and select Properties Window.  

3. Select Properties tab. In the Typename field, enter ReadSOSync. 

4. The Solution Explorer should now look similar to the following diagram.  
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Add shapes to the orchestration 

This section provides instructions to add shapes to the orchestration. 

1. Open ReadSOSync.odx.  

2. Using the Toolbox, drag and drop the following shapes in the sequence shown:   

a) Receive  

b) Message Assignment  

c) Send  

d) Receive  

e) Message Assignment 

f) Send  

Configure Multi-part Message Types  

This section provides instructions to configure the multi-part message types. The ReadSOSync 
orchestration will use the read request and read response message types. The UpdateSOSync 
orchestration will use the update request and update response message types. The DeleteSOSync 
orchestration will use the delete request and delete response message types.  

As discussed in the earlier section, the AIF does not provide a return value in the response for the 
update and delete operations. You will need to customize the orchestration to provide a return value in 
the response for the update and delete operations. Therefore, you will customize the UpdateSOSync 
and the DeleteSOSync orchestrations to provide a return value. Configure the Multi-part Message 
Types using the following steps: 

1. Configure SalesOrderService_read_Request. Select Orchestration View.  Expand Types > 
Multi-part Message Types > SalesOrderService_read_Request.  

a) Right-click _entityKeyList and select Properties Window. 

b) In the Type field, expand Schemas and click <Select from Referenced Assembly…> from 
the list. 

c) In the Select Artifact Type window, expand References > 
Microsoft.Dynamics.BizTalk.Adapter.Schemas > {} Dynamics.Ax5 in the left pane. 
Select EntityKeyList in the right pane.   

2. Configure SalesOrderService_read_Response. Expand Types > Multi-part Message Types 

> SalesOrderService_read_Response. Right-click ReturnValue and select Properties 
Window. Confirm that the Type field is set to 
AIFSOWalkthrough.SalesOrderService_SalesOrder. 

3. Configure SalesOrderService_update_Request. You need to customize the orchestration to 
send a return value in the response from the update operation. To accomplish this task, you need 
to add MessageParts to the message type. The update request message uses MessageParts, 

instead of using _entityKeyList and _salesSalesOrder, to receive an update request.  The 
update response uses MessageParts to provide the response.  

a) Expand Types > Multi-part Message Types > SalesOrderService_update_Request.  

b) Right-click _entityKeyList and select Properties Window.  

c) Set Identifier = updateRequestMessageParts. 

d) In the Type field, expand Schemas, and then click <Select from Referenced 
Assembly…> from the list.  
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e) In the Select Artifact Type window, expand References > 
Microsoft.Dynamics.BizTalk.Adapter.Schemas > {} DynamicsAx5.Message in the left 
pane. Select MessageParts in the right pane. 

f) In the Orchestration View pane, expand Multi-part Message Types and then expand 

SalesOrderService_update_Request. Right-click _salesSalesOrder and click Delete.  

4. Configure SalesOrderService_update_Response. In this step, you will add MessageParts to 
the message type. The UpdateSOSync orchestration will use the MessageParts to provide a 
response from the update operation later in this document.  

a) Navigate to Types > Multi-part Message Types > 
SalesOrderService_Update_Response.  

b) Right-click SalesOrderService_Update_Response and then click New Message Part.  

c) Set Identifier = updateResponseMessageParts.  

d) In the Type field, expand Schemas, and then click <Select from Referenced Assembly…> 
from the list.  

e) In the Select Artifact Type window, expand References > 
Microsoft.Dynamics.BizTalk.Adapter.Schemas > {} DynamicsAx5.Message in the left 
pane. Select MessageParts from the right pane. 

5. Configure SalesOrderService_delete_Request. As discussed earlier, you need to customize the 
orchestration to send a return value in the response from the delete operation. To accomplish this 
task, you need to add MessageParts to the message type. The delete request message uses 
MessageParts, instead of _entityKeyList, to receive a delete request.  The delete response uses 
MessageParts to provide the response.  

a) Expand Types > Multi-part Message Types > SalesOrderService_delete_Request.  

b) Right-click _entityKeyList and select Properties Window.  

c) Set Identifier = deleteRequestMessageParts. 

d) In the Type field, expand Schemas, and then <Select from Referenced Assembly…> 
from the list.  

e) In the Select Artifact Type window, expand References > 
Microsoft.Dynamics.BizTalk.Adapter.Schemas > {} DynamicsAx5.Message in the left 
pane. Select MessageParts in the right pane. 

6. Configure SalesOrderService_delete_Response. In this step, you will add MessageParts to 

the message type. The DeleteSOSync orchestration will use the MessageParts to provide a 
response from the delete operation.  

a) Navigate to Types > Multi-part Message Types > 
SalesOrderService_delete_Response.  

b) Right-click SalesOrderService_delete_Response and then click New Message Part.  

c) Set Identifier = deleteResponseMessageParts.  

d) In the Type field, expand Schemas, and then click <Select from Referenced Assembly…> 
from the list. In the Select Artifact Type window, expand References > 
Microsoft.Dynamics.BizTalk.Adapter.Schemas > {} DynamicsAx5.Message in the left 
pane. Select MessageParts in the right pane. 
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Create messages and set properties 

This section provides instructions to create messages that are used in this orchestration and to set the 
message properties.  

1. Click Orchestration View tab.  

a) Right-click Messages node and click New Message. This step will create a new message with 
an identifier of Message_1.  

b) Repeat the preceding step and create three new messages: Message_2, Message_3, and 
Message_4. 

2. Right-click Message_1 and select Properties Window. Set the properties for this message as 
follows: 

 Identifier = Message_EK_InfromFile 

 In the Message Type field, expand Schemas, and then click <Select from Referenced 
Assembly…> from the list. In the Select Artifact Type window, expand References > 
Microsoft.Dynamics.BizTalk.Adapter.Schemas > {} DynamicsAx5 in the left pane. 
Select EntityKeyList in the right pane. Click OK. 

3. Set the properties for Message_2 as follows:  

 Identifier = Message_ ReadSORequest_BTStoAX 

 In the Message Type field, expand Multi Part Message Types and select 
AIFSOWalkthrough.SalesOrderService_read_Request from the list. 

4. Set the properties for Message_3 as follows:  

 Identifier = Message_ ReadSOResponse_AXtoBTS 

 In the Message Type field, expand Multi Part Message Types and select 
AIFSOWalkthrough.SalesOrderService_read_Response from the list. 

5. Set the properties for Message_4 as follows:  

 Identifier = Message_ SOReturn_OuttoFile 

 In the Message Type field, expand Schemas, and then select 
AIFSOWalkthrough.SalesOrderService_SalesOrder from the list. 

Create and configure ports 

This section provides instructions to create and configure ports that are used in the orchestration. 

1. From the Toolbox, drag a Port shape on the Port Surface to the left side of the orchestration. 
Drop the port shape parallel to the Receive_1 shape. Instructions to complete the Port 
Configuration Wizard are as follows. 

a) Click Next on the Welcome to the Port Configuration Wizard window. 

b) Set Name to Port_EKList_InfromFile and click Next. BizTalk uses this port to receive the 
entity key list from the inbound file folder.  

c) Set Port Type Name to PortType_EKList_InfromFile and click Next. 

d) In the Port direction of communication field, select I’ll always be receiving messages 
on this port from the list. Click Next.  

e) Click Finish. 

2. From the Toolbox, drag a Port shape on the Port Surface to the left side of the orchestration. 
Drop the port shape near shape Send_1. Instructions to complete the Port Configuration 
Wizard are as follows. 

a) Click Next on the Welcome to the Port Configuration Wizard window. 



 

 

16 
 
APPLICATION INTEGRATION FRAMEWORK (AIF) BIZTALK ADAPTER CONFIGURATION FOR DATA EXCHANGE, PART II 

b) Set Name to Port_SalesOrderServiceSync and click Next. BizTalk uses this port to send a 
read request to the AIF and receive a read response from the AIF.  

c) Click the Use an existing Port type radio button.  

d) Click AIFSOWalkthrough.SalesOrderService_Sync. 

e) Click Next. 

f) In the Port direction of communication field, select I’ll be sending a request and 
receiving a response from the list and click Next.  

g) Click Finish. 

h) Confirm that Port_SalesOrderServiceSync contains delete, read, and update operations on 
the Port Surface.  

3. From the Toolbox, drag a Port shape on the Port Surface to the left side of the orchestration. 

Drop the port shape parallel to shape Send_2. Instructions to complete the Port Configuration 
Wizard are as follows. 

a) Click Next on the Welcome to the Port Configuration Wizard window. 

b) Set Name to Port_SendSO_OuttoFile and click Next. BizTalk uses this port to send the sales 
order to the outbound file folder. 

c) Set Port Type Name to PortType_SendSO_OuttoFile and click Next. 

d) In the Port direction of communication field, select I’ll always be sending messages on 
this port from the list. Click Next.  

e) Click Finish. 

Configure shapes 

This section provides instructions to configure the shapes that we added earlier to the orchestration. 
Use the following steps in the Orchestration window to configure shapes. 

1. Right-click the shape Receive_1 and select Properties Window.  

a) Set property values as follows: 

 Activate = True (from the list) 

 Message = Select Message_EK_InfromFile (from the list) 

 Name = Receive_EK 

Note: You need to click anywhere outside the Name field for the name of the shape to 
change from Receive_1 to Receive_EK. This applies to all the shapes. 

b) Connect Port_EKList_InfromFile with shape Receive_EK by dragging the Port Connector 
Line in Visual Studio. 

2. Configure shape ConstructMessage_1.  

a) Set property values as follows: 

 Message_Constructed = Select Message_ReadSORequest_BTStoAX (from the list) 

 Name = ConstructMessage_EK 

b) Double-click MessageAssignment_1 within shape ConstructMessage_EK. Copy or type the 
following code into the BizTalk Expression Editor. Note that the code makes references to 
the local and remote endpoints. Make sure the values entered in the code are those entered 
on the AIF configuration forms.  

  Message_ReadSORequest_BTStoAX._entityKeyList = Message_EK_InfromFile; 

Message_ReadSORequest_BTStoAX(DynamicsAx5.DestinationEndpoint) = "LocalEP"; 
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Message_ReadSORequest_BTStoAX(DynamicsAx5.SourceEndpoint) = "RemoteEP"; 

Message_ReadSORequest_BTStoAX(DynamicsAx5.Action) = 

"http://schemas.microsoft.com/dynamics/2008/01/services/SalesOrderService/read";  

c) Click Apply and then click OK. 

3. Configure shape Send_1.  

a) Set property values as follows: 

 Message = Select Message_ReadSORequest_BTStoAX (from the list) 

 Name = Send_ReadSO_Request 

b) Connect shape Send_ReadSO_Request with the message type 
SalesOrderService_read_Request as shown in the following screen shot.  

4. Configure shape Receive_2.  

a) Set property values as follows: 

 Message = Select Message_ReadSOResponse_AXtoBTS (from the list) 

 Name = Receive_ReadSO_Response 

b) Connect shape Receive_ReadSO_Response with the message type 
SalesOrderService_read_Response in port Port_SalesOrderServiceSync by dragging 
the Port Connector Line in Visual Studio. 

5. Configure shape ConstructMessage_2. In this step, the orchestration constructs the message 

that will be placed in the outbound file folder.  

a) Set property values as follows: 

 Message_Constructed = Select Message_SOReturn_OuttoFile (from the list) 

 Name = ConstructMessage_SalesOrder 

b) Double-click MessageAssignment_1 within shape ConstructMessage_SalesOrder. Copy or type 
the following code into the BizTalk Expression Editor.  

  Message_SOReturn_OuttoFile = Message_ReadSOResponse_AXtoBTS.ReturnValue; 

c) Click Apply and then click OK. 

6. Configure shape Send_2.  

a) Set property values as follows: 
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 Message = Select Message_SOReturn_OuttoFile (from the list) 

 Name = Send_SalesOrder_ToFile 

b) Connect shape Send_SalesOrder_ToFile with the port Port_SendSO_OuttoFile by 
dragging the Port Connector Line in Visual Studio. 

c) Your orchestration should look similar to the following screen shot. 

7. Save the project.  
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Create an orchestration to update a sales order 

This section provides step-by-step instructions to create and configure the synchronous orchestration 
to update a sales order. Use the following steps to create the orchestration. 

 Add the orchestration 

 Add shapes to the orchestration. 

 Create messages and set properties 

 Create and configure ports 

 Configure shapes 

Add the orchestration 

When you created the ReadSOSync orchestration, you already selected the update operation. You do 

not need to add the adapter metadata again. You need to add an orchestration to the project.  

1. In the Solution Explorer pane, right-click AIFSOWalkthrough. Select Add and click New 
Item.  

2. When the Add New Item – AIFSOWalkthrough window opens, select BizTalk Orchestration.  

a) In the Name field, enter UpdateSOSync.  

b) Click Add. 

Add shapes to the orchestration 

Open UpdateSOSync.odx. Using the Toolbox, drag and drop the following shapes in the order 
shown:   

1. Receive  

2. Message Assignment  

3. Send  

4. Receive  

5. Message Assignment 

6. Send  

Create messages and set properties 

This section provides instructions to create messages that are used in this orchestration and set the 
message properties.  

1. Click Orchestration View tab.  

a) Right-click Messages node and click New Message. This step will create a new message with 
an identifier of Message_1.  

b) Repeat the preceding step and create three new messages: Message_2, Message_3, and 

Message_4. 

2. Right-click Message_1 and select Properties Window. Set the properties for this message as 
follows: 

 Identifier = Message_ReceivedUpdateRequestMessageParts_InfromFile 

 In the Message Type field, expand Schemas, and then click <Select from Referenced 
Assembly…> from the list. In the Select Artifact Type window, expand References > 
Microsoft.Dynamics.BizTalk.Adapter.Schemas > {} DynamicsAx5.Message in the left 

pane. Select MessageParts in the right pane. Click OK. 
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3. Set the properties for Message_2 as follows:  

 Identifier = Message_ UpdateSORequest_BTStoAX 

 In the Message Type field, expand Multi Part Message Types and select 
AIFSOWalkthrough.SalesOrderService_update_Request from the list. 

4. Set the properties for Message_3 as follows:  

 Identifier = Message_ UpdateSOResponse_AXtoBTS 

 In the Message Type field, expand Multi Part Message Types and select 
AIFSOWalkthrough.SalesOrderService_update_Response from the list. 

5. Set the properties for Message_4 as follows:  

 Identifier = Message_ UpdateResponse_OuttoFile 

 In the Message Type field, expand .NET Classes and then select System.String. 

Create and configure ports 

This section provides instructions to create and configure ports that are used in the orchestration. 

1. From the Toolbox, drag a Port shape on the Port Surface to the left side of the orchestration. 
Drop the port shape parallel to the Receive_1 shape. Instructions to complete the Port 
Configuration Wizard are as follows. 

a) Click Next on the Welcome to the Port Configuration Wizard window. 

b) Set Name to Port_ReceiveUpdateRequestMessageParts_InfromFile and click Next. BizTalk 
uses this port to receive the update request document from the inbound file folder.  

c) Set Port Type Name to PortType_ ReceiveUpdateRequestMessageParts_InfromFile and click 
Next. 

d) In the Port direction of communication field, select I’ll always be receiving messages 

on this port from the list. Click Next.  

e) Click Finish. 

2. From the Toolbox, drag a Port shape on the Port Surface to the left side of the orchestration. 
Drop the port shape near shape Send_1. Instructions to complete the Port Configuration 
Wizard are as follows. 

a) Click Next on the Welcome to the Port Configuration Wizard window. 

b) Set Name to Port_SalesOrderService_Update and click Next. BizTalk uses this port to send an 
update request to the AIF and receive an update response from the AIF.  

c) Click the Use an existing Port type radio button.  

d) Click AIFSOWalkthrough.SalesOrderService_Sync. 

e) Click Next. 

f) In the Port direction of communication field, select I’ll be sending a request and 

receiving a response from the list and click Next.  

g) Click Finish. 

h) Confirm that Port_SalesOrderService_Update contains delete, read and update operations 
on the Port Surface.  

3. From the Toolbox, drag a Port shape on the Port Surface to the left side of the orchestration. 
Drop the port shape parallel to shape Send_2. Instructions to complete the Port Configuration 
Wizard are as follows. 

a) Click Next on the Welcome to the Port Configuration Wizard window. 
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b) Set Name to Port_SendUpdateResponse_OuttoFile and click Next. BizTalk uses this port to 
send the sales order to the outbound file folder. 

c) Set Port Type Name to PortType_ SendUpdateResponse_OuttoFile and click Next. 

d) In the Port direction of communication field, select I’ll always be sending messages on 

this port from the list. Click Next.  

e) Click Finish. 

Configure shapes 

This section provides instructions to configure the shapes that you added earlier to the orchestration. 
Use the following steps in the Orchestration window to configure shapes.  

1. Right-click the shape Receive_1 and select Properties Window.  

a) Set property values as follows: 

 Activate = True 

 Message = Select Message_ReceivedUpdateRequestMessageParts_InfromFile (from the 
list) 

 Name = Receive_UpdateRequest 

Note: You need to click somewhere outside of the Name field for the name of the shape to 

change from Receive_1 to the new name. This applies to all the shapes. 

b) Connect Port_ReceiveUpdateRequestMessageParts_InfromFile with shape 
Receive_UpdateRequest by dragging the Port Connector Line in Visual Studio. 

2. Configure shape ConstructMessage_1. 

a) Set property values as follows: 

 Message_Constructed = Select Message_UpdateSORequest_BTStoAX (from the list)  

 Name = ConstructMessage_UpdateRequest 

b) Double-click MessageAssignment_1 within shape ConstructMessage_UpdateRequest. 
Copy or type the following code in BizTalk Expression Editor. Note that the code makes 
references to the local and remote endpoints. You created these endpoints earlier using the 
AIF configuration forms in Microsoft Dynamics AX. Make sure the values are those entered on 
the AIF configuration forms.  

  Message_UpdateSORequest_BTStoAX.updateRequestMessageParts =  

Message_ReceivedUpdateRequestMessageParts_InfromFile; 

Message_UpdateSORequest_BTStoAX(DynamicsAx5.DestinationEndpoint) = "LocalEP"; 

Message_UpdateSORequest_BTStoAX(DynamicsAx5.SourceEndpoint) = "RemoteEP"; 

Message_UpdateSORequest_BTStoAX(DynamicsAx5.Action) = 

"http://schemas.microsoft.com/dynamics/2008/01/services/SalesOrderService/updat

e"; 

c) Click Apply and then click OK. 

3. Configure shape Send_1.  

a) Set property values as follows: 

 Message = Select Message_UpdateSORequest_BTStoAX (from the list)  

 Name = Send_UpdateSO_Request 
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b) Connect shape Send_UpdateSO_Request with the message type 
SalesOrderService_Update_Request in port Port_SalesOrderService_Update by 
dragging the Port Connector Line in Visual Studio as shown in the following screen shot. 

4. Configure shape Receive_2.  

a) Set property values as follows: 

 Message = Select Message_UpdateSOResponse_AXtoBTS (from the list) 

 Name = Receive_UpdateSO_Response 

b) Connect shape Receive_UpdateSO_Response with the message type 

SalesOrderService_Update_Response in port Port_SalesOrderService_Update by 
dragging the Port Connector Line in Visual Studio. 

5. Configure shape ConstructMessage_2. In this step, the orchestration constructs the message 
that will be placed in the outbound file folder.  

a) Set property values as follows: 

 Message_Constructed = Select Message_UpdateResponse_OuttoFile (from the list) 

 Name = ConstructMessage_UpdateResponse. 

b) Double-click MessageAssignment_1 within shape ConstructMessage_UpdateResponse. Copy 
or type the following code into the BizTalk Expression Editor.  

  Message_UpdateResponse_OuttoFile =  System.String.Format("Update successful for  

message Id '{0}'", 

Message_UpdateSOResponse_AXtoBTS(DynamicsAx5.RequestMessageId)); 

c) Click Apply and then click OK. 

6. Configure shape Send_2.  

a) Set property values as follows: 

 Message = Select Message_UpdateResponse_OuttoFile (from the list) 

 Name = Send_UpdateResponse_ToFile 

b) Connect shape Send_UpdateResponse_ToFile with the port 
Port_SendUpdateResponse_OuttoFile by dragging the Port Connector Line in Visual 
Studio. 
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c) Your orchestration should look similar to the following screen shot. 

7. Save the project.  
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Create an orchestration to delete a sales order 

This section provides step-by-step instructions to create and configure the synchronous orchestration 
to delete a sales order. Use the following steps to create the orchestration. 

 Add the orchestration 

 Add shapes to the orchestration. 

 Create messages and set properties 

 Create and configure ports 

 Configure shapes 

Add the orchestration 

When you created the ReadSOSync orchestration, you already selected the delete operation. So you 

only need to add an orchestration to the project.  

1. In the Solution Explorer pane, right-click AIFSOWalkthrough. Select Add and click New 
Item.  

2. When the Add New Item – AIFSOWalkthrough window opens, select BizTalk Orchestration.  

a) In the Name field, enter DeleteSOSync.  

b) Click Add. 

Add shapes to the orchestration 

Open DeleteSOSync.odx. Using the Toolbox, drag and drop the following shapes in the order 
shown:   

1. Receive  

2. Message Assignment  

3. Send  

4. Receive  

5. Message Assignment 

6. Send  

Create messages and set properties 

This section provides instructions to create messages that are used in this orchestration and set the 
message properties.  

1. Click Orchestration View tab.  

a) Right-click Messages node and click New Message. This step will create a new message with 
an identifier of Message_1.  

b) Repeat the preceding step and create three new messages: Message_2, Message_3, and 

Message_4. 

2. Right-click Message_1 and select Properties Window. Set the properties for this message as 
follows: 

 Identifier = Message_ReceivedDeleteRequestMessageParts_InfromFile 

 In the Message Type field, expand Schemas, and then click <Select from Referenced 
Assembly…> from the list. In the Select Artifact Type window, expand References > 
Microsoft.Dynamics.BizTalk.Adapter.Schemas > {} DynamicsAx5.Message in the left 

pane. Select MessageParts in the right pane. Click OK. 
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3. Set the properties for Message_2 as follows:  

 Identifier = Message_ DeleteSORequest_BTStoAX 

 In the Message Type field, expand Multi Part Message Types and select 
AIFSOWalkthrough.SalesOrderService_delete_Request from the list. 

4. Set the properties for Message_3 as follows:  

 Identifier = Message_ DeleteSOResponse_AXtoBTS 

 In the Message Type field, expand Multi Part Message Types and select 
AIFSOWalkthrough.SalesOrderService_delete_Response from the list. 

5. Set the properties for Message_4 as follows:  

 Identifier = Message_ DeleteResponse_OuttoFile 

 In the Message Type field, expand .NET Classes, and then select System.String. 

Create and configure ports 

This section provides instructions to create and configure ports that are used in the orchestration. 

1. From the Toolbox, drag a Port shape on the Port Surface to the left side of the orchestration. 
Drop the port shape parallel to the Receive_1 shape. Instructions to complete the Port 
Configuration Wizard are as follows. 

a) Click Next on the Welcome to the Port Configuration Wizard window. 

b) Set Name to Port_ReceiveDeleteRequestMessageParts_InfromFile and click Next. BizTalk 
uses this port to receive the delete request document from the inbound file folder.  

c) Set Port Type Name to PortType_ ReceiveDeleteRequestMessageParts_InfromFile and click 
Next. 

d) In the Port direction of communication field, select I’ll always be receiving messages 

on this port from the list. Click Next.  

e) Click Finish. 

2. From the Toolbox, drag a Port shape on the Port Surface to the left side of the orchestration. 
Drop the port shape near shape Send_1. Instructions to complete the Port Configuration 
Wizard are as follows. 

a) Click Next on the Welcome to the Port Configuration Wizard window. 

b) Set Name to Port_SalesOrderService_Delete and click Next. BizTalk uses this port to send a 
delete request to the AIF and receive a delete response from the AIF.  

c) Click the Use an existing Port type radio button.  

d) Click AIFSOWalkthrough.SalesOrderService_Sync. 

e) Click Next. 

f) In the Port direction of communication field, select I’ll be sending a request and 

receiving a response from the list and click Next.  

g) Click Finish. 

h) Confirm that Port_SalesOrderService_Delete contains delete, read and delete operations 
on the Port Surface.  

3. From the Toolbox, drag a Port shape on the Port Surface to the left side of the orchestration. 
Drop the port shape parallel to shape Send_2. Instructions to complete the Port Configuration 
Wizard are as follows. 

a) Click Next on the Welcome to the Port Configuration Wizard window. 
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b) Set Name to Port_SendDeleteResponse_OuttoFile and click Next. BizTalk uses this port to 
send the sales order to the outbound file folder. 

c) Set Port Type Name to PortType_SendDeleteResponse_OuttoFile and click Next. 

d) In the Port direction of communication field, select I’ll always be sending messages on 

this port from the list. Click Next.  

e) Click Finish. 

Configure shapes 

This section provides instructions to configure the shapes that you added earlier to the orchestration.  

1. Configure shape Receive_1.  

a) Select Orchestration window. Right-click the shape Receive_1 and select Properties 

Window. Set property values as follows: 

 Activate = True 

 Message = Select Message_ReceivedDeleteRequestMessageParts_InfromFile (from the 
list) 

 Name = Receive_DeleteRequest 

Note: You need to click somewhere outside of the Name field for the name of the shape to 

change from Receive_1 to the new name. This applies to all the shapes. 

b) Connect Port_ReceiveDeleteRequestMessageParts_InfromFile with shape 
Receive_DeleteRequest by dragging the Port Connector Line in Visual Studio. 

2. Configure shape ConstructMessage_1  

a) Set property values as follows: 

 Message_Constructed = Select Message_DeleteSORequest_BTStoAX (from the list) 

 Name = ConstructMessage_DeleteRequest 

b) Double-click MessageAssignment_1 within shape ConstructMessage_DeleteRequest. 
Copy or type the following code into the BizTalk Expression Editor. Note that the code 
makes references to the local and remote endpoints. Make sure the values entered in the code 
are those entered on the AIF configuration forms.  

  Message_DeleteSORequest_BTStoAX.deleteRequestMessageParts =  

Message_ReceivedDeleteRequestMessageParts_InfromFile; 

Message_DeleteSORequest_BTStoAX(DynamicsAx5.DestinationEndpoint) = "LocalEP"; 

Message_DeleteSORequest_BTStoAX(DynamicsAx5.SourceEndpoint) = "RemoteEP"; 

Message_DeleteSORequest_BTStoAX(DynamicsAx5.Action) = 

"http://schemas.microsoft.com/dynamics/2008/01/services/SalesOrderService/delet

e"; 

c) Click Apply and then click OK. 

3. Configure shape Send_1.  

a) Set property values as follows: 

 Message = Select Message_DeleteSORequest_BTStoAX (from the list) 

 Name = Send_DeleteSO_Request 
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b) Connect shape Send_DeleteSO_Request with the message type 
SalesOrderService_Delete_Request in port Port_SalesOrderService_Delete by dragging 
the Port Connector Line in Visual Studio as shown in the following screen shot. 

4. Configure shape Receive_2.  

a) Set property values as follows: 

 Message = Select Message_DeleteSOResponse_AXtoBTS (from the list)  

 Name = Receive_DeleteSO_Response 

b) Connect shape Receive_DeleteSO_Response with the message type 
SalesOrderService_Delete_Response in port Port_SalesOrderService_Delete by 
dragging the Port Connector Line in Visual Studio. 

5. Configure shape ConstructMessage_2. In this step, the orchestration constructs the message 
that will be placed in the outbound file folder.  

a) Set property values as follows: 

 Message_Constructed = Select Message_DeleteResponse_OuttoFile (from the list) 

 Name = ConstructMessage_DeleteResponse 

b) Double-click MessageAssignment_1 within shape ConstructMessage_DeleteResponse. 
Copy or type the following code into the BizTalk Expression Editor.  

  Message_DeleteResponse_OutToFile =  System.String.Format("Delete successful for  

message Id '{0}'", 

Message_DeleteSOResponse_AXtoBTS(DynamicsAx5.RequestMessageId)); 

c) Click Apply and then click OK. 

6. Configure shape Send_2.  

a) Set property values as follows: 

 Message = Select Message_DeleteResponse_OuttoFile (from the list)  

 Name = Send_DeleteResponse_ToFile 

b) Connect shape Send_DeleteResponse_ToFile with the port 
Port_SendDeleteResponse_OuttoFile by dragging the Port Connector Line in Visual 

Studio. 

  



 

 

28 
 
APPLICATION INTEGRATION FRAMEWORK (AIF) BIZTALK ADAPTER CONFIGURATION FOR DATA EXCHANGE, PART II 

c) Your orchestration should look similar to the following screen shot. 

7. Save the project.  

  



 

 

29 
 

APPLICATION INTEGRATION FRAMEWORK (AIF) BIZTALK ADAPTER CONFIGURATION FOR DATA EXCHANGE, PART II 

Create a strong name key 

You will need to create and assign a strong name key to compile the Visual Studio project.  

1. Open a command prompt window and navigate to C:\Program Files\Microsoft Visual Studio 
8\SDK\v2.0 \Bin.  

2. Type sn –k “c:\ AIFSOWalkthrough.snk” and press Enter. Make sure you get a message that a 
key pair was written as shown in the following screen shot. 

 

Build and deploy the Visual Studio project 

You are now ready to build the Visual Studio project and deploy it to the BizTalk Server. 

1. In Visual Studio 2005 navigate to Project > AIFSOWalkthrough Properties. 

2. Expand Common Properties and click Assembly in the left pane. Locate and click Assembly 
Key File in the right pane. Click the ellipses in the Assembly Key File field. Navigate to the 
location of the strong name key file that was created in the preceding section and select the file 

(C:\AIFSOWalkthrough.snk).  

3. In the left pane, expand Configuration Properties and click Deployment. Set the following 
property values: 

 Server = AX-SRV-01 

 Application Name = AIFSOWalkthrough. The value you set in this field will be used as the 
BizTalk application. 

4. Click Apply and then click OK. 

5. In the Solution Explorer pane, right-click AIFSOWalkthrough.  

a) Click Deploy. 

b) Check the status bar to confirm that the deployment is successful. 
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Configure orchestration in BizTalk Server 

This section provides instructions to configure the synchronous orchestrations in the BizTalk Server 
2006 Administration Console. To begin: 

1. Launch the BizTalk Server 2006 Administration Console. If the administrative console is 
already launched, you need to right-click the BizTalk group and click Refresh. 

2. Navigate to AIFSOWalkthrough by expanding parent nodes as shown in the following screen 

shot. Right-click AIFSOWalkthrough and select Configure. 
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Configure the DeleteSOSync orchestration 

1. Click DeleteSOSync. This is the DeleteSOSync.odx orchestration in the Visual Studio 2005 
project.  

2. In the Host field, select BizTalk Server Application from the list. 

Configure receive port Port_ReceiveDeleteRequestMessageParts_InfromFile 

1. In the Configure Applications window, click <None> in the 
Port_ReceiveDeleteRequestMessageParts_InfromFile field and select <New Receive 
Port…> from the list. 

2. In the Receive Port Properties window, set the Name to ReceivePort1_SODelete then click 
Receive Locations (in the left pane). 

3. In the Receive Locations pane, click New. Set properties as follows: 

a) Name = Receive Location SODelete Inbound 

b) In the Type field, select File from the list and click Configure. 

c) In the File Transport Properties window, click Browse.  

d) Create a new folder that will be used as the inbound folder. Name the folder SODelete. Select 

SODelete and click OK. 

e) Click OK to continue. 

4. Set Receive pipeline to XMLReceive, click Apply and then click OK. 

5. Click OK to return to the Configure Application window. 

Configure send port Port_SalesOrderService_Delete 

In this step, you will configure the AIF BizTalk adapter for the send port. 
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1. In the Configure Application window, click <None> in Port_SalesOrderService_Delete field 
and then select < New Send Port…> from the list. 

2. In the Send Port Properties window, set property values as follows: 

 Name = SendPort1_AX_Adapter 

 In the Type field, select Microsoft Dynamics AX 2009 from the list and then click 
Configure. 

3. In the Microsoft Dynamics AX 2009 Transport Properties window, set the following property 
values:  

 Authentication Type = Select Proxy User from the list 

 Gateway User = contoso\administrator 

 Proxy User = contoso\administrator 

 Proxy User Password = Password of the proxy user (“pass@word1” for this walkthrough).  

 AOS Port = 2712 

 AOS Server = AX-SRV-01 

 Click Apply and then click OK. 

4. In the Send Port Properties window, click Apply and then click OK. 

Configure send port Port_SendDeleteResponse_OuttoFile 

In this step, you will map an outbound file folder with the send port. You can either create a unique 
file folder for each send port or you can reuse the same folder for all the send ports. This document 
will reuse the same outbound folder for all the send ports that use the file system.  

1. In the Configure Application window, click <None> in the Port_ 
SendDeleteResponse_OuttoFile field and then select <New Send Port… > from the list. 

2. In the Send Port Properties window, set property values as follows: 

a) Name = SendPort1_SODelete 

b) In the Type field, select File from the list and then click Configure. In the File Transport 
Properties window, click Browse. Create a new folder that will be used as the outbound 
folder. Name the folder SOOut. Select SOOut and click OK. 

c) Set the File name field to SODelete%MessageID%.xml. All the messages coming from this 
port to the folder will be prefixed with “SODelete”. This way, you can identify different 
messages coming from different send ports.  

3. Click OK to continue. 

4. Set Send pipeline to XMLTransmit, click Apply, and then click OK. 

5. Click OK to return to the Configure Application window. 
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Configure the ReadSOSync orchestration  

1. In the Configure Application window, click ReadSOSync. This is the ReadSOSync.odx 
orchestration in the Visual Studio 2005 project.  

2. In the Host field, select BizTalk Server Application from the list. 

Configure receive port Port_EKList_InfromFile 

1. In the Configure Application window, click <None> in the Port_EKList_InfromFile field and 
select <New Receive Port…> from the list. 

2. In the Receive Port Properties window, set the Name to ReceivePort_SORead, then click 
Receive Locations in the left pane. 

3. In the Receive Locations pane, click New. Set properties as follows: 

a) Name = Receive Location SORead  

b) Type = Select File from the list and click Configure 

c) In the File Transport Properties window, click Browse. Create a new folder that will be 
used as the receive folder. Name the folder SORead. Select SORead and click OK. 

d) Click OK to continue. 

4. Set Receive pipeline to XMLReceive, click Apply and then click OK. 

5. Click OK to return to the Configure Application window. 

Configure send port Port_SalesOrderServiceSync 

In the Configure Application window, click <None> in Port_SalesOrderServiceSync field and 
then select SendPort1_AX_Adapter from the list. Within a given application, you can have only one 

instance of the AIF BizTalk adapter defined as a send port.  

Configure send port Port_SendSO_OuttoFile 

1. In the Configure Application window, click <None> in the Port_ 
SendDeleteResponse_OuttoFile field and then select <New Send Port… > from the list. 

2. In the Send Port Properties window, set property values as follows: 

a) Name = SendPort1_SORead 

b) In the Type field, select File from the list and then click Configure.  

c) In the File Transport Properties window, click Browse. Locate and select folder SOOut and 
click OK. 

d) Set the File name field to SORead%MessageID%.xml. All the messages coming from this 
send port to the file folder will be prefixed with “SORead”.   

e) Click OK to continue. 

3. Set Send pipeline to XMLTransmit and click Apply and then click OK. 

4. Click OK to return to the Configure Application window. 
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Configure the UpdateSOSync orchestration  

1. In the Configure Application window, click UpdateSOSync. This is the UpdateSOSync.odx 
orchestration in the Visual Studio 2005 project.  

2. In the Host field, select BizTalk Server Application from the list. 

Configure receive port Port_ReceiveUpdateRequestMessageParts_InfromFile 

1. In the Configure Application window, click <None> in the 
Port_ReceiveUpdateRequestMessageParts _InfromFile field and select <New Receive 

Port…> from the list. 

2. In the Receive Port Properties window, set the Name to ReceivePort1_SOUpdate then click 
Receive Locations in the left pane. 

3. In the Receive Locations pane, click New. Set properties as follows: 

a) Name = Receive Location SOUpdate 

b) In the Type field, select File from the list and click Configure. In the File Transport 
Properties window, click Browse. Create a new folder that will be used as the receive folder. 

Name the folder SOUpdate. Select SOUpdate and click OK. 

4. Click OK to continue. 

5. Set Receive pipeline to XMLReceive, click Apply and then click OK. 

6. Click OK to return to the Configure Application window. 

Configure send port Port_SalesOrderService_Update 

In the Configure Application window, click <None> in Port_SalesOrderService_Update field and 

then select SendPort1_AX_Adapter from the list. Within a given application, you can create only 
one instance of the AIF BizTalk adapter as a send port.  

Configure send port Port_SendSO_OuttoFile 

1. In the Configure Application window, click <None> in the Port_ 
SendUpdateResponse_OuttoFile field and then select <New Send Port… > from the list. 

2. In the Send Port Properties window, set property values as follows: 

a) Name = SendPort1_SOUpdate 

b) In the Type field, select File from the list and then click Configure.  

c) In the File Transport Properties window, click Browse. Locate and select folder SOOut and 
click OK. 

d) Set the File name field to SOUpdate%MessageID%.xml. 

e) Click OK to continue. 

3. Set Send pipeline to XMLTransmit and click Apply and then click OK. 

4. Click OK to return to the Configure Application window. 
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5. Your Configure Application window should look similar to the following screen shot. 

6. Click OK to close the Configure Application window and return to the BizTalk 2006 
Administrative Console. 

Enable the receive locations. 

This section and the following section provide instructions to work with receive locations, send ports, 
and the orchestration individually. Alternatively, you can right-click the application and then select 
Start to automatically start all related receive locations, send ports, and the orchestration.  

Click the Receive Locations node in the BizTalk Server 2006 Administration Console. Select the 
three locations that you created earlier. Right-click the selection and click Enable.  
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Start the send ports.  

Click the Send Ports node in the left pane. Select the four send Ports that you created earlier. Right-
click the selection and click Start.  

 

Start the orchestration.  

Select the Orchestrations node. Select the three orchestrations that you configured earlier. Right-

click the selection and click Start. 

 

  



 

 

37 
 

APPLICATION INTEGRATION FRAMEWORK (AIF) BIZTALK ADAPTER CONFIGURATION FOR DATA EXCHANGE, PART II 

Restart the host instances.  

Select Platform Settings > Host Instances in the left pane. Right-click BiztalkServerApplication 
and click Restart. 

Configure AIF batch jobs, tasks, and recurrence schedule 

You must configure AIF batch jobs and batch tasks to process the documents. You also need to define 
an appropriate recurrence schedule for AIF jobs. For the purpose of this white paper, we have set the 
recurrence schedule at one minute. See the Configuring the Application Integration Framework (AIF) 
BizTalk adapter for data exchange white paper for instructions to configure AIF batch jobs, tasks, and 
recurrence schedule.  

  

http://www.microsoft.com/downloads/details.aspx?familyid=edc62433-5b21-4f74-b065-b075ba6dc86d&displaylang=en&tm
http://www.microsoft.com/downloads/details.aspx?familyid=edc62433-5b21-4f74-b065-b075ba6dc86d&displaylang=en&tm
http://www.microsoft.com/downloads/details.aspx?familyid=edc62433-5b21-4f74-b065-b075ba6dc86d&displaylang=en&tm
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Read the sales order and test results 

This section provides instruction to test the asynchronous orchestration that reads a sales order from 
BizTalk. 

Create an XML document for the asynchronous test 

In this walkthrough, BizTalk sends the following XML document to the AIF to read the sales order. 
There is no endpoint or action information in this XML file—that information is added to the message 
in the BizTalk orchestration.  You need to create an XML document for a sales order that exists in your 
test system as shown in the following screen shot. Save the XML document with an appropriate name. 
For the purposes of this white paper, save the document as ReadSalesOrder.xml. 

Read the sales order in synchronous mode 

Copy the XML file to the folder C:\SORead. This is the folder that you have configured for the 
synchronous orchestration ReadSOSync. BizTalk Server will monitor the folder and will pick up the file. 
When you refresh the folder C:\SORead, you should see nothing in it.  
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Test the sales order read operation  

The AIF processes the incoming XML from BizTalk Server and sends a sales order containing all the 
enabled fields to BizTalk Server in an XML document. BizTalk Server places the XML document in the 
outbound folder C:\SOOut. You can use the XML file in the outbound folder and the Microsoft 
Dynamics AX client to validate the test results as follows: 

1. Verify that BizTalk has placed the sales order in the outbound folder by checking the C:\TestOut 
folder. In this walkthrough, you have configured C:\TestOut as the outbound folder for all the 
orchestrations. You should see an XML document with a name such as SORead{E3999436-2CB8-

4BE2-BFCB-30085776256F}.xml. This XML document provides the sales order as shown in the 
following screen shot.  

2. In the Microsoft Dynamics AX client, navigate to Accounts receivable > Common Forms > 
Sales Order Details. Confirm that the sales order document provides valid results.  
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Update the sales order and test results 

This section provides instructions to create a process to test the synchronous orchestration that 
updates a sales order from BizTalk. Now that you have read a sales order from the AIF with a 
document hash, you are ready to update the sales order from BizTalk.  

Create an XML document for the update operation 

When creating a BizTalk application in Visual Studio, you changed the multi-part message types to use 
the MessageParts element. Therefore, you now need to format the sales order to use the 
MessageParts element. You also need to determine the fields that you update for this sales order. For 
the purpose of this exercise, you will change the quantity field from 5 to 10. The following screen shot 
shows the XML that you can use to test the update operation. For the purposes of this white paper, 

save the document as UpdateSalesOrder.xml. Make sure to copy the document hash from the sales 
order document you received from the AIF in the preceding step. If the document hash you send does 

not match the document hash in Microsoft Dynamics AX, the AIF will reject your update.  
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Update the sales order in synchronous mode 

Copy the XML file to folder C:\SOUpdate. This is the folder that you have configured for the 
synchronous orchestration UpdatetSOSync. BizTalk Server will monitor the folder and will pick up the 
file. When you refresh the folder C:\SOUpdate, you should see nothing in it.  

Test the update and the return value 

The AIF processes the incoming XML from BizTalk Server and updates the sales order. The 
orchestration uses the custom code to send a return value in the response to BizTalk. BizTalk Server 
places the XML document in the outbound folder C:\SOOut. You can use the XML file in the outbound 
folder and the Microsoft Dynamics AX client to validate the test results as follows: 

1. Verify that BizTalk has placed the sales order in the outbound folder by checking C:\TestOut 
folder. In this walkthrough, you have configured C:\TestOut as the outbound folder for all 
orchestrations. You should see an XML document with a name such as SOUpdate{E3999436-

2CB8-4BE2-BFCB-30085776256F}.xml. The document should resemble the following screen shot. 
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2. In the Microsoft Dynamics AX client, navigate to Accounts receivable > Common Forms > 
Sales Order Details. Confirm that the quantity is updated in the sales order.  
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Delete the sales order and test results 

This section provides instructions to test the orchestration that deletes a sales order from BizTalk.  

Create an XML document for the delete operation 

When you created a BizTalk application in Visual Studio, you changed the multi-part message types to 

use the MessageParts element. To delete a sales order, you need to send the sales order within the 
MessageParts element as shown in the following screen shot. Create an XML document from the 
following screen shot and save it DeleteSalesOrder.xml. 

Delete the sales order in synchronous mode 

Copy the XML file to folder C:\SODelete. This is the folder that you have configured for the 

synchronous orchestration DeleteSOSync. BizTalk Server will monitor the folder and will pick up the 
file. When you refresh the folder C:\SODelete, you should see nothing in it.  
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Test the delete and the return value 

The AIF processes the incoming XML from BizTalk Server and deletes the sales order. The AIF does 
not automatically provide a return value in the response for the delete operation. The orchestration 
uses custom code to provide a return value in the response . BizTalk Server places the XML document 
in the outbound folder C:\SOOut. You can use the XML file in the outbound folder and the Microsoft 
Dynamics AX client to validate the test results as follows: 

1. Verify that BizTalk has placed the sales order in the outbound folder by checking C:\TestOut 
folder. In this walkthrough, you have configured C:\TestOut as the outbound folder for all 

orchestrations. You should see an XML document with a name such as SODelete{E3999436-2CB8-
4BE2-BFCB-30085776256F}.xml. The document should resemble the following screen shot. 

 

2. In the Microsoft Dynamics AX client, navigate to Accounts receivable > Common Forms > 
Sales Order Details. Confirm that sales order SO-101328 is deleted.  
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Troubleshooting 

If you get an error message, check your configuration settings in Microsoft Dynamics AX, BizTalk 
Server, and the Visual Studio project. Also check the XML schema of your document and make sure all 
the required fields are included. This section provides information on additional tools that you can use 
to troubleshoot error messages. 

Microsoft Dynamics AX client 

Errors might typically result from an invalid XML schema or improper settings of the AIF configuration. 
You can use the following tools to determine the source of the error. 

1. Check the AIF Exceptions form. To launch the form, select Basic > Periodic > Application 
Integration Framework > Exceptions. Use this form to view exceptions including processing 

errors, warnings, and informational messages that are related to document exchanges and other 
AIF events.  

For more information, see "The error log and queue management" in the Server and Database 
Administration Guide.  

 

2. Check the AIF Document history form. To launch the form, select Basic > Periodic > 
Application Integration Framework > Document history. Use this form to track the history 
of documents that are transferred. To save copies of the XML code for these documents, click 
Document logs.  For more information, see the topic "Viewing the document log" in the Server 
and Database Administration Guide.  

 

Windows event log 

Launch the Windows Event Viewer and check the Application and System logs to view error 
messages from BizTalk Server, Visual Studio and Microsoft Dynamics AX. Check the configuration 
settings in the Visual Studio and BizTalk Server Administration Console. For more information on 
specific error messages, refer to the system documentation for these products.  

  

http://go.microsoft.com/fwlink/?LinkID=99628
http://go.microsoft.com/fwlink/?LinkID=99628
http://go.microsoft.com/fwlink/?LinkID=99628
http://go.microsoft.com/fwlink/?LinkID=99628
http://go.microsoft.com/fwlink/?LinkID=99628
http://go.microsoft.com/fwlink/?LinkID=99628
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